MAPPING BASICS WITHIN GOOGLE EARTH PRO

Step by step tutorial
# TABLE OF CONTENTS

1. INTRODUCTION TO GOOGLE EARTH ................................................................................................ 3

2. NAVIGATION IN GOOGLE EARTH ...................................................................................................... 4
   2.1. FIND A LOCATION ............................................................................................................................. 5
       2.1.1. MANUAL LOCATION .................................................................................................................. 5
       2.1.2. SEARCH FOR A PLACE BY NAME ........................................................................................... 5
       2.1.3. SEARCH FOR A LOCATION BY COORDINATES ..................................................................... 5
   2.2. UNDERSTANDING THE NAVIGATION CONSOLE ........................................................................... 6
   2.3. LOST? FIND THE RIGHT ANGLE AND DIRECTION ......................................................................... 8

3. STORING DATA IN CACHE ................................................................................................................ 9

4. LAYER MANAGEMENT IN GOOGLE EARTH ...................................................................................... 10
   4.1. DISPLAY OF PRIMARY LAYERS ....................................................................................................... 10
       4.1.1. ADDING LOCAL IMAGES AS A BACKGROUND MAP ................................................................. 10

5. CREATING DATA IN GOOGLE EARTH (POINTS, LINES, POLYGONS) ............................................ 12
   5.1. CREATE FOLDERS IN MY PLACES .................................................................................................. 12
   5.2. CREATION OF GEOSPATIAL DATA ................................................................................................. 13
       5.2.1. CREATION AND MODIFICATION OF PLACEMARKS (POINTS) .................................................. 13
       5.2.2. CREATE AND EDIT PATH (LINE) .............................................................................................. 13
       5.2.3. CREATE AND MODIFY POLYGON ............................................................................................ 14
   5.3. POINTS FROM A CSV FILE ............................................................................................................ 15
       5.3.1. CONVERTING XLS TO CSV .................................................................................................... 15
       5.3.2. IMPORT THE CSV INTO GOOGLE EARTH PRO ....................................................................... 16

6. STYLIZATION OF DATA .................................................................................................................... 19
   6.1. FOR LINES AND POLYGONS ....................................................................................................... 19
   6.2. FOR POINTS .................................................................................................................................. 19
   6.3. SHARE THE STYLE IN A FOLDER ................................................................................................... 19

7. EXPORTING YOUR GOOGLE EARTH MAP ...................................................................................... 20
   7.1. EXPORTING A MAP AS AN IMAGE ............................................................................................... 20
       7.1.1. SAVE AS A MAP IN GOOGLE EARTH PRO ............................................................................ 20
   7.2. EXPORTING PROJECT DATA TO KML ........................................................................................... 21

8. UNDERSTANDING GOOGLE EARTH FILE MANAGEMENT ................................................................... 22
8.1. KML OR KMZ ? ............................................................................................................................................. 22
8.2. MY PLACES AND TEMPORARY PLACES .................................................................................................... 22
8.3. TIPS AND TRICKS FOR PROPER DATA MANAGEMENT ........................................................................... 23
   8.3.1. WISE THINGS TO DO ................................................................................................................................. 23
   8.3.2. MISTAKES TO AVOID ................................................................................................................................. 23
9. IMPORT GPS DATA ........................................................................................................................................... 23
   9.1. FIND YOUR DATA IN THE GPS DEVICE ..................................................................................................... 23
   9.2. IMPORT INTO GOOGLE EARTH ................................................................................................................. 24
   9.3. CLEANING OF DATA OBTAINED IN GOOGLE EARTH .............................................................................. 25
1. INTRODUCTION TO GOOGLE EARTH

Google Earth is Google's proprietary software, which provides a geographic visualisation of our planet. It maps the Earth by aggregating images from satellite imagery, aerial photography and geographic information systems (GIS) into a 3D globe that is easy to navigate and explore.

It also offers various possibilities:

- Adding various geospatial data, available online or by importing local files
- Create and modify personal spatial data by drawing and saving them
- Visualise and create multimedia content such as images and videos, spatial animations and temporal changes.
- Working with three-dimensional elements: buildings, elevations, etc.
- Share spatial information privately or within the Google Earth community

It can be considered the most commonly used basic mapping software. Although its features are not powerful enough to perform complex analysis or produce beautiful maps, Google Earth is a very useful geospatial visualisation tool.

Google Earth is a free tool available on the Internet. The web version is available here. To download the Pro version, go to https://www.google.fr/earth/download/gep/agree.html

💡 The Pro version of Google Earth is available legally and free of charge on the internet. The Google Earth product is no longer maintained by Google.
2. NAVIGATION IN GOOGLE EARTH

The Google Earth interface offers many shortcuts to help you navigate the Earth easily and change views. Some of these can help you work much faster and enjoy your work with Google Earth more. Let’s try them out using the location of your choice - for this training we will use a remote part of the world, often the site of humanitarian operations, as an example: the city of Faizabad in Afghanistan (Badakhshan province).

1. **Menu bar** (File, Edit, View, Tools, Add, Help) - gives you access to many of the options and features of Google Earth.
2. **Toolbar** - The toolbar at the top of the Earth image has icons for the most useful functions, such as adding pins, adding a path, displaying a ruler, or sending the image by email.
3. **Navigation Tool** - The Navigation Console is your primary tool for navigating in Google Earth. You can also use your mouse and the CTRL key.
4. **Information bar** - The information bar provides you with information about where your eye is, where your mouse is pointing, and the image displayed in Google Earth.
5. **Search Panels** - The search bar allows you to find a location on Earth by entering an address, place or latitude and longitude coordinates.
6. **My Places** - The My Places area (middle left) provides a section where you can organize your own data and Google base layers.
7. **Layers panel** - The default layers offered by Google Earth, you can choose to enable certain layers to enhance the data in your map.
2.1. **Find a Location**

Google Earth offers the possibility to browse the spatial extent of the Earth, Mars, the Moon and the Sky. Only the Earth function will be covered in this course. You can find your place of interest using several different means.

2.1.1. **Manual Location**

If you already know where the place you are looking for is on Earth, you can manually pan and zoom to the right extent using the navigation tool, your mouse and your keyboard (see Understanding the navigation console).

2.1.2. **Search for a Place by Name**

If you don’t know where to find the place you are interested in, or if you want to save time, you can use the search function. As the software includes extensive databases of locations, searching for places on Google Earth is quick and easy.

Use the **Search tab** and type in the place you are looking for. Note that Google Earth will suggest similar places. Giving details about the place you are interested in will speed up the search and avoid confusion.

Press the Enter key or the Find button. If you have entered the correct location details, your screen content in the 3D viewer will be moved to the desired location.

2.1.3. **Search for a Location by Coordinates**

If you don’t know the name of the place you are interested in, but you have its GPS coordinates, you can enter them directly into the search field. Google Earth accepts the following coordinate notations:

<table>
<thead>
<tr>
<th>Type of coordinates</th>
<th>Explanation</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal Degrees (DD)</td>
<td>The decimal precision is defined in the &quot;degree&quot; coordinate.</td>
<td>49.11675953666N</td>
</tr>
<tr>
<td>Degrees, minutes and seconds (DMS)</td>
<td>The decimal precision is defined in the &quot;seconds&quot; coordinate.</td>
<td>49 7'20.06 &quot;N</td>
</tr>
<tr>
<td>Degrees, minutes and decimal seconds (DMM)</td>
<td>The decimal precision is defined in the &quot;minutes&quot; coordinate.</td>
<td>49 7.0055722 &quot;N. (Here, the above 20.06 seconds are divided by 3600 to obtain the decimal value of minutes for 20.06 seconds).</td>
</tr>
</tbody>
</table>

N/S and E/W coordinates should be separated by a space and a comma. Details on the syntax of latitudes and longitudes are available on the Google Earth Support website at the following link: [https://support.google.com/earth/answer/148074#entering](https://support.google.com/earth/answer/148074#entering).
If you have difficulties entering coordinates, we recommend converting them to decimal degrees (DD), as these coordinates are the easiest to manage and enter into Google Earth. Online converters can be found in many places on the Internet, such as https://www.earthpoint.us/Convert.aspx.

### 2.2. Understanding the Navigation Console

Imagine that all information displayed on GE is "seen" from a hypothetical satellite on which you are embedded. You can freely use three commands:

1. **Pan** - Move the satellite itself over the area you wish to see.
2. **Zoom** - Move your satellite closer or further from the ground - you can also SCROLL to zoom in.
3. **Eye** - Rotate the satellite to rotate the map, or to get a plan view to use Eye movements.

Shortcut: Use the arrows on your keyboard or the hand tool to move north, south, east and west. You can also click and drag in the 3D viewer to achieve the same effect.
To rotate around a point on the map, you can either use the north mark on the eye tool, hold down the SHIFT key + the left/right arrow on your keyboard, or hold down the 'CTRL' key and scroll your mouse up/down.

If you rotate your map too much and want North to appear at the top, you can simply click on the "N" icon at the top of the navigation console.

One of the most interesting features of Google Earth is that it allows you to get a 3D view, as if you were looking at the Earth from a plane instead of a flat satellite image. While this gives clear and comprehensive views of your work, it can be difficult to make it work.

To switch your view from vertical to "aeroplane mode", you can either hold CTRL + click and drag on your screen, or hold CTRL + the up/down arrow.
2.3. Lost? Find the Right Angle and Direction

Now you're lost in Google Earth ... your North is pointed in the wrong direction, and you're looking at the ground at the wrong angle, and as you click around, the world is spinning or moving very fast.

Far from Faizabad, the North points to the South-East, too close to the ground: I am lost.

Getting back to normal is very easy. There are only two keys to press on your keyboard:

<table>
<thead>
<tr>
<th></th>
<th>The N key will take you back to North at the top</th>
<th>Orientation back to normal</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="N" /></td>
<td><img src="image" alt="N" /></td>
<td><img src="image" alt="N" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Pressing the U key will return you to the top view (satellite view)</th>
<th>Sight restored to normal</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="U" /></td>
<td><img src="image" alt="U" /></td>
<td><img src="image" alt="U" /></td>
</tr>
</tbody>
</table>

💡 Instead of pressing "N" and then "U", pressing the "R" key will combine both effects!
3. STORING DATA IN CACHE

Do you regularly use Google Earth as a mapping tool? Are you going on an emergency mission with limited internet connectivity? If so, you may want to take certain areas offline to view imagery even when you have no internet. In computer terms, this is called "caching imagery".

- Open Google Earth on your computer
- **First, go to the Tools > Options menu and select the "Cache" tab.**
  - Do not touch the Memory Cache, as this will slow down your computer: leave it at 500MB or any other default value.
  - Set the Disk Cache to 2000 MB (2 Gigabytes)
- Press the "Clear Memory Cache" button to clear Google Earth of all previous data.
- Then navigate to the area of your choice and browse it manually. You want to visit it all, at the smallest zoom level\(^1\) that you will need to use on the ground, to force Google Earth to store them. Watch how the satellite image tiles "load" (they are blurred at first and then gain in quality).
- Close Google Earth: the next time you reopen it, the satellite images will be accessible offline.

**Warning:** The maximum size you can "cache" is 2000Mb. This means that you cannot store an entire country offline (and it would take hours to "visit" it at the maximum zoom level). However, storing a medium-sized city or region (about 50x50km) usually works.

More advanced options allow you to save larger areas, but they require a greater understanding of the software and (to some extent) administrator rights on your computer. It is advisable to consult your IT manager before trying them:
- *Creating a local cache on Google Earth* (video)
- *Google Earth blog post on cache manipulation*

\(^1\) The “lowest zoom level”, in TI/GIS terms, means "the maximum zoom".
4. LAYER MANAGEMENT IN GOOGLE EARTH

4.1. DISPLAY OF PRIMARY LAYERS

In the lower left corner of the main Google Earth interface screen you will find the layers panel. It contains a list of spatial information layers stored on the Internet. You can display them by checking the box to the left of each layer name.

The primary database included as standard in Google Earth contains many useful layers such as international, national and regional borders, rivers, roads, places, water bodies, coastlines, Wikipedia links, 3D buildings, live weather information, Panoramic world photos, etc.

Take time to explore the contents of the Primary Database, make sure you unfold each line by clicking on the small blue triangle on the left. Note that some information may only be displayed when you have zoomed in sufficiently. For others, by clicking on the points, lines or areas displayed, you can get additional information in the form of pop-up windows.

Caution: Do not try to display too many layers at the same time (especially if you have a limited connection), as this will overload your viewing windows and use up a huge amount of Internet bandwidth.

4.1.1. ADDING LOCAL IMAGES AS A BACKGROUND MAP

Finally, you can also add your own images as background in Google Earth. Let's say you want to use this UNDP map of the Horn of Africa

First, save the image to your computer.

In Google Earth, you can use the Add Image Overlay button located in the toolbar. Clicking it opens a window with several options - click the Browse button and locate the image you want to add as a background in Google Earth.
Once your map is displayed, set the Transparency slider to 50%. You will notice that your map is not in the right place - it is not aligned and scaled with the base world boundaries as they are displayed on Google Earth. Keeping the New Image Overlay window open, use the green lines that appear on your new image to move, scale and rotate it until it meets the Google Earth boundaries.

- Click and drag the central green cross to move your image.
- Click and drag one of the **green corners to scale** your image.
- Click and drag the **green diamond to rotate** your image.

Once your image is in the right place, give it a name in the New Image Overlay window and click OK.
5. CREATING DATA IN GOOGLE EARTH (POINTS, LINES, POLYGONS)

Google Earth also allows you to create, edit and share geospatial content, so that you can show on the maps things that relate directly to you and your humanitarian work. The features you can create in Google Earth are

- **Points** (also called Placemarks, Points of interest, Landmarks, Pinpoints)
- **Lines** (also called Paths)
- **Polygons**

If used correctly, these three types of geographic objects can represent almost anything.

### 5.1. CREATE FOLDERS IN My Places

To create your own data in Google Earth, you need to use the **Places** toolkit. It consists of two main folders: **My Places** and **Temporary Places**.

See *Managing your data in Google Earth* to learn more about how to organise your records.

Right-click on My Places > Add > Folder. Name it "Training".

**IMPORTANT:** Each time you create or edit an object, you must ensure that you have selected that folder in the "Places" box. The selected folder appears highlighted in light blue. If this is not the case, a left click on the folder will select it.

Once you have created and selected the "Training" folder, you are ready to create geospatial objects.
5.2. **Creation of Geospatial Data**

### 5.2.1. Creation and Modification of Placemarks (Points)

Use the **Add Placemark** button in the toolbar.

A pop-up window and a yellow dot will appear (you may have to drag the pop-up window to the side of the screen if it hides the dot). You can then:

- **Click and drag** the point to locate it on the map.
- ... or enter the contact details manually if you know them.
- **Give it a name** in the "Name" field (e.g. "My first placemark").
- **Add a brief description** of the item in the "Description" field.
- **Change the point symbol** by clicking on the icon button.

When you have finished, click OK to confirm the creation of the points. The information entered in the description box will appear as a descriptive pop-up when you click on your finished point.

The landmark you have created will be referenced in the Places box in the Training folder. To modify a created waypoint, you can right-click on it and select **Properties**. The landmark properties window reopens and allows you to change the location, name, symbol and description of your landmark.

### 5.2.2. Create and Edit Path (Line)

Adding lines works in the same way as creating a placemark. Make sure you have selected the 'Training' folder in My Toolbox (or any other working folder you may have created previously), then click on the 'Add Path' button.

To create a line, you must click several times on the map. The first click will create the starting point of the line, then each click will be used to draw the line. Using the **Style-Colour** tab you can change the thickness, transparency and colour of your line, to make it easier to see. Click OK to confirm when your line is drawn.
In the same way that a landmark can be changed or deleted later in the Places box, it is possible to do the same with a line/path by right-clicking and selecting **Properties**.

Get more information:

- You can find the length of the path created by going to the last tab "Measures".
- You can see the elevation profile of the created path: **right-click on it in the left panel "Places" > Show elevation profile** (this option only works online).

### 5.2.3. Create and Modify Polygon

Adding polygons is another option available in the toolbar:

Polygons are created in the same way as lines, by clicking several times to draw the shape of the polygon you wish to create. However, unlike lines and paths, it also has a colour in the centre area. In the Style-Colour tab you can change the appearance of the outline and the appearance of the inner area separately.

It is advisable to set the transparency of the inner area to 50%, as this will allow you to see what is under the shape you are drawing on the map, rather than hiding it completely. Add the name and description and click OK to confirm.

Like landmarks and lines, polygons can be edited by right-clicking in the **My Places** box.
5.3. **Points from a CSV file**

In Google Earth Pro, you can import data from a CSV file (tabular data) if it has columns with geographic coordinates. This data can come from external sources on the Internet or be data you have collected yourself.

### 5.3.1. Converting XLS to CSV

First, make sure that the data you want to import contains geographical information (latitude and longitude expressed in decimal degrees).

If the data you have is in excel format, simply convert it to CSV: File > Save as > in "Save as type" choose CSV (Comma Delimited).
5.3.2. **Import the CSV into Google Earth Pro**

File > Import > Choose your CSV file >

1. **Specify the text delimiter**
2. **Specify encoding**
3. **Check the overview**
4. **Click on Next**

5. **Select latitude and longitude fields if your data contains them**
6. **Click on Next**
7. Indicate the type of each field
   Reminder:
   - **String** = text
   - **Integer** = Integer
   - **Floating point** : Decimal number

   Remember to set your **latitude/longitude** fields as floating commas.

8. Click on finish

A pop-up window will appear asking if we want to apply a style template to the data we are going to import, this will allow us to define categories and a style according to the fields in our table, select Yes.

A Style Template Settings window opens.

The Name tab allows you to define the field in your table that will be used to label the data.

In the Icon tab, you can define how the data will be represented. You can apply the same symbol for all data or create categories based on a field.
To apply different symbols according to a field: check "Define icon from field" > choose the **field on which you want to base the differentiation** > check "create sub-folders for each bucket" to have one sub-folder per category > select the **icon you want for each category** and give a name to the **folder** that will be created > click **OK**.

You can save this style and these categories in a Google Earth (.kst) format for later import. If you don't want to save them, just click on **Cancel**.

You now have your data imported from the CSV file, styled differently depending on the field chosen.
6. STYLIZATION OF DATA

6.1. FOR LINES AND POLYGONS
You can give your data a custom look in Google Earth by clicking on an item (point, line, polygon) and then going to Properties. Once in the properties window, you will also need to access the Style and Colour tab. Here you can change the following properties:

- The colour, width and opacity of the lines (of the outline, in the case of a polygon).
- The colour and opacity of a polygon fill area (central part).

6.2. FOR POINTS
For points, you do not need to access a style tab, just go to the properties window (right click > Properties). Then click on the symbol to the right of the name. You can then change the symbol used to represent the point.

You can also add a custom icon, for example a logo, by clicking on the "Add custom icon" button at the bottom and selecting an image file from your computer.

**NOTE:** If you use custom symbols, please save your work to Google Earth later using a KMZ file and not a KML file. This will store the custom icon IN your Google Earth file, making it available even if the file is opened on another computer.

6.3. SHARE THE STYLE IN A FOLDER
You can apply the same symbol to all the elements contained in the same folder. To do this, right-click on the folder concerned > Properties > go to the Style, Colour tab.
The button to change the icon is greyed out, to make the style editable click on "Share Style" at the bottom of the window. You can now define the symbology to be applied to each element of this folder (icon, colour, size, label...).

7. EXPORTING YOUR GOOGLE EARTH MAP

You have now finished drawing and saving the features you wanted to see on Google Earth. Now it's time to export your map as a final image for decision makers or save your spatial data (locations) to share with a colleague.

7.1. EXPORTING A MAP AS AN IMAGE

Instead of taking a screenshot every time you need one, it is possible to export what you see in Google Earth as an image by clicking on the Menu bar: File > Save > Save Image. You can then navigate to any folder on your computer and save the map extent displayed in the 3D viewer as a .jpg image, which you can then include in a Word report or send by email.

Unlike a screenshot, neither the right side panel (Search, Places, Layers), nor the navigation console, nor the menu and toolbar will be included in the image. However, the Google Earth logo will remain on your exported image and you are not allowed to crop, edit, delete or hide it.

7.1.1. SAVE AS A MAP IN GOOGLE EARTH PRO

Google Earth Pro now allows you to export your work into a map template that includes a title, legend, north arrow and scale bar. In the toolbar, click on the "Save Image" button to open this template. The legend is automatically filled in by the elements displayed in the view. You can change the title and the legend by clicking on them.
If the characteristics listed in the legend do not match the characteristics displayed in the view: **click on the legend to edit it** > at the bottom of the window click on "Refresh from view".

- You can also check or uncheck the characteristics you do not want to appear in the legend.
- To rename items in the legend, double-click on them.

### 7.2. Exporting Project Data to KML

Exporting image files is great, but it doesn't give you the ability to share an editable Google Earth file in the same way you would, for example, with a Word document. If you need to send your items to someone else for viewing, editing or simply to create a backup of your locations, you can also export them to .kml files.

Keyhole Markup Language (kml) files are native to Google Earth, just as .doc files are native to Microsoft Word. They allow you to save and reopen points, lines and polygons from Google Earth. You can save either individual objects (points, lines, polygons) or folders containing multiple objects in a KML file.
To save the Training folder used earlier in this course, right-click on the folder name in the Places box and select Save Place As. You can then navigate to any folder on your computer, give it a name and save it as a KML file for later use or to send by email.

8. UNDERSTANDING GOOGLE EARTH FILE MANAGEMENT

8.1. KML OR KMZ?

KMZ is a second format used by Google Earth. It is very similar, the main difference being that if you are using custom symbols (a Tdh logo from your computer for example), saving in KMZ will store your custom icon inside the KMZ. If you use the KML format, it will not be stored inside; therefore, it will only work on a computer that has the same Tdh logo stored on disk.

8.2. MY PLACES AND TEMPORARY PLACES

The Places panel in Google Earth is one of its most important features. As soon as you want to go beyond simple data visualisation and start managing your own data, it will be your main management tool.

Places are always separated into two different folders. It is very important to understand the difference between the two, as confusion between these folders is the source of regular data loss among Google Earth users.

- My places

Your personal storage space in Google Earth. Items saved in this folder are permanent (they appear every time you open the software). My Places is a storage space within Google Earth and can store items without any specific KML files being saved to your disk (unlike normal office software like Word or Excel). Your data can always be exported later as KML files for external storage or to share via email.

- Temporary locations

Folder where the KML files you open or the items you create in Google Earth are stored without defining a specific destination folder.

**Warning:** Whenever you close Google Earth, the contents of the Temporary Places folder are deleted forever, and it is currently not possible to recover them.

Comments:

In the Places panel, you can move an item from Temporary Places to My Places by right-clicking > Save to My Places. You can also drag and drop folders from one folder to another.

You can organise My Places into several folders and subfolders to represent your different maps, projects and courses: this will help you keep a clean and complete toolkit, avoiding data loss and errors. Remember to always check which folder is currently selected in My Places (highlighted in light blue). Every
time you perform an operation in Google Earth (creating a place, importing GPS data, etc.), it applies to the folder selected in My Places and in this one.

It is not always easy to see which folder is selected, and clicking on items in the map windows can result in unexpected changes, so keep an eye on your selection.

Finally, remember that once saved on your computer, the KML files of existing items/folders are completely independent of the items/folders saved in My Places, even though they may look similar. Reopening and editing a saved KML file will NOT change the original, unless you save it back to My Places, and vice versa.

8.3. **TIPS AND TRICKS FOR PROPER DATA MANAGEMENT**

**8.3.1. WISE THINGS TO DO**

Make a regular (weekly or monthly) backup of your entire My Places folder, and keep it in a safe place on your disk. In the event of a serious crash, you may need to reinstall Google Earth completely, deleting all the data in the Places folder.

**8.3.2. MISTAKES TO AVOID**

Create many items without checking that you have selected the correct folder in My Places, as you may have to manually place them in the correct folder later.

Close Google Earth without checking the temporary files folder to see if there are any files you forgot to save.

Multiple saves/openings of the same KML file without cleaning up previously opened files - you will get confused between several folders with the same name in My Places.

9. **IMPORT GPS DATA**

*This training assumes that you are using standard GPS units, mainly GARMIN. Importing from other devices generally follows the same principles, but with possible variations. If necessary, consult the Garmin eTrex30 GPS manual available online: https://support.garmin.com/fr-FR/?partNumber=010-00970-20&tab=manuals.*

When your GPS is loaded with spatial information (waypoints and/or tracks collected in the field), opening it is quite simple. The data will be stored in a file with the extension .GPX, which Google Earth is able to open if we instruct it to do so, indicating what to look for and where.

**9.1. FIND YOUR DATA IN THE GPS DEVICE**

You will need your GPS unit and a USB cable to connect it to the computer. Once plugged in, the GPS will be installed and displayed in the same way as a USB stick (assuming the Windows drivers are working correctly).

All information is stored in the GARMIN/GPX files. Tracks and waypoints are then stored in different files, both using a specific date and time to help you identify them.
9.2. Import into Google Earth

There are three ways to import these files into Google Earth:

- By drag and drop

From your Windows Explorer windows, simply select the GPS file you wish to import and drag it into Google Earth.

**IMPORTANT:** Do NOT drop it in the main map window but rather in the Places window. Even if it is technically possible to drop it directly from the map, dropping it in the Places folder list will force you to think about where you want to place your data: In Temporary Places? In my places? In a custom folder that you will create?

It is recommended that you first open and examine your GPS data in temporary locations.

- By File > Open

Google Earth can simply open GPX files like any other file, through the File > Open menu. But you must then go to the File Type list (button on the right of the Open windows) and tell Google Earth that you are looking for .GPX files - otherwise they will NOT be visible and you will not be able to open them.

*Note also that many other file formats are available, especially if you use Google Earth Pro - including SHP Shapefiles. However, it is NOT recommended to open Shapefiles in Google Earth.*
Via the GPS import tool

A final way to import data is to simply plug in the GPS device with the USB cable, without searching for files, and use the Google Earth menus: Tools > GPS > Import.

However, expect possible bugs with this method (depending on the version of Windows and drivers). It can be used as an alternative if necessary.

9.3. **Cleaning of data obtained in Google Earth**

Whichever method you use, you will notice that your data will appear in a double folder called "GPS Device":

Move this folder to permanent storage

Only then: delete the empty "GPS Device" cell